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1 7= ki
1.1 P2 IR

M ¢ PM-127 SE8L T 8 f1 PROFIBUS-DP il 5 . Al H A Modbus RTU/ASCII (RS485)
B R %545 3] PROFIBUS-DP, B Modbus/RS485 [ 4% 14 £ #64t Jy PROFIBUS-DP % 2% %% 4 o

1.2 P2

VA2 FLHA RS485 # L1f# Modbus RTU/ASCIT i # #5m] LUK I A b S 8L 5 B 3 2
PROFIBUS I H.#%. Wl: HA Modbus Pl 1A Higs . BALUESIREE . B RE IS i ds . A i
B OSFPARIRLS . B AR LI R s S AR AR

VW B P AN T fi# PROFIBUS #1 Modbus HR40 T, H ™ R TES % AT W AR R FH S, f4fE
BORGERCE, ANTEE A, W 7ERT I (0] P s IR 15 .

VIBINESS: 7 LUK PROFIBUS A5 24 X R Modbus 115 £ X (ML X &, SEIL PROFIBUS %
Modbus 2 [8] 1) £ 432 B 815

1.3 BARTEDR

[1] PM-127 M 5&4 PROFIBUS {llj /& —> PROFIBUS-DP ¥k, 7E Modbus —f{lllj& MODBUS . Mulin]#; il
ik PROFIBUS #4540 X M1 Modbus ## X () 4k Wi S 3 PROFIBUS 1 MODBUS )£k 2 W13E 47
[2] PM-127 WA Modbus %, % FF 01H. 02H. 03H. 04H. 05H. 06H. OFH. 10H SIjfitfid; LAl
fit & 48 % Modbus 4
[3] PM-127 W 5AE A Modbus Mi, SCFF Modbus Zf7ds il 3 X (3xxxx). 4 X (dxxxx). 0 X (Oxxxx) Fl
1 X (xxxx)s Hr, 3 XSZHFFDIBERD 04H; 4 XSCRFLDIAERS 03H. O6H. 10H; 0 XSCRFLIAERS 01H. O5H.
OFH: 1 X3ZHFLIAERY 02H;
[4] PROFIBUS-DP/VO thi¥, 45 JB/T 10308.3-2001: il & Al A0 Al 5 ol R4 FH I B 228
3 #%43: PROFIBUS Miii;
[5] PROFIBUS-DP Mifi, AR HIGN, SCRAEFFRIEH: 9600~12Mbps;
[6] PROFIBUS #i A\ /&t 7 5 Fnl i@ ik Step7 H ¥ &, fix K PROFIBUS i A /4t -

(DMax Input Bytes <244Bytes

(2Max Output Bytes <244 Bytes
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(3Max Data Bytes <488 Bytes
[7] RASEHLLIRE: /E) Modbus £ ¥li, Profibus i n] LAHE . Modbus 72 4R%: E5 Modbus Mufi, Profibus
s v LA A Modbus M 454k 7
[8] MODBUS PiHs4% H /& RS-485 #2101, EXUT; EF%: 300, 600, 1200, 2400, 9600, 19200, 38400, 57600,
115200bps 7] 3%; 8 i Ay ; AL r(fl. #F Jo. Axid Sk Ark; fF1bAr (1. 2) wlik;
[9] fitH: 24VDC (11V-30V), 80mA (24V DC)
[10] TAEIRESIRSE: -20°C ~60°C, FXHRE 5% ~95% (TohktiEz)
[11] AMERSF: 100mm (KD x70mm (%5) x25mm ()
[12] “%#%: 35mm $5L
[13] Bii4a52%: 1P20

1.4 FHFRA R
1.4.1 ETPLAL( GB/T15153.1 classIll )

FEL 5 N [P 3% 0] Hb
Jit i1 3% it RN El
AT U AN B 6
51 Pk EE 2.5~3kV
PR A 1.0~1.5MHz
TN 1/2 TEPRIN [7) >6ps
MR 50 [H1 LA F/s
RGBT 150~200Q

1.4.2 IR Bk FER 5 ( GB/T17626.4 classIll )

B ARSI B e 2KV
IR §5 11 1V
ER AR 5 kHz

1.4.3 B H T GB/T 17626.2 classIll )

Ttz P SIS I B AR i oy
HUF . L 6V AZRAMTAE, TR IS NI {E LI 22.5A
UK BEAE 1 FPLLEfTaI R 10 1L L
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Wtk TEAR

1.4.4 %E 5 BB RE3%( GBIT 17626.3 classIll)

LY AR 150MHz, 400MHz, 900MHz
53 10 V/m
LR AR A 75 OR 25 B ity 1, DT 45 O L 9
1.5 FHRF= M
/NIRRT D R TR DR

PM-160, PM-125, PM-126 %&
IR LL L JLE™ Ui B, i 10 23 7] I S www.sibotech.net, B8 3RFTH AR SRR . 021-5102 8348

1.6 RNi&
PROFIBUS-DP: PROFIBUS-DP 1/piY

RS485: —Ff e L A Y
PM-127: Modbus(RS485)/PROFIBUS-DP ¥ %
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2 FEah I

2.1 FRamah

PROFIBUS-DP
W 4IRS KT

PROFIBUS-DP ¥ [l

PROFIBUS Hh i 1%
B

PROFIBUS-DP Hhhik

IR

RS-485 i [ Al

HIPRER AT At e
2.2 8T
BT RE X
STA ZRAT TN AR PROFIBUS-DP £k b5 ¥i¥siifi
(PROFIBUS-DP MZ%R A48 7540) LA K To s A
PBF AR o= PROFIBUS-DP it 2 £ His i {5 I
(PROFIBUS-DP MZ5R A48 547) AR B A 1E
RX SEAT IN R o B
CH ERIRZSFR 7R AT SEET K R
TX 24T R R IE A o
CRIPRESHR R SEET K o RIE
-5-
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2.3 HHAL ML E

® JiiifE: kN Profibus-DP HihlA& Ul & U B ) Profibus-DP Hihil-
® i Thfe: WoR 4T Profibus-DP il

PM-127 EHUSEERNE IEH AR, %% IR Profibus Hililk, %52,

ki AHEN Profibus Hihl B BRA CHUBA @ IR, AROLH 52D, Ml By n—, Khedigid
2.5s UI#e 3 EARAL M bE CEOSE mfr i 58 ARALINRD), Bl A n—, Kiedcdind 2.5s RAFFT il &
AR AL, FRENIERIRAS T R BN

BRIEHERASSMO HARE, Bt 10s TTHANE, AZARAEER Y APIRASEAN EHARE,

F L B BCE VAT

HUR IR E e

R

1B AR, B
Profibusiihik, 5 55

Xkt 4%

& & Profibus-DPh
Bk A AR 5
i, BN

K5/ 125

& & Profibus-DP
AR, mhLH R
L, BN

KA ¥ d 2.5, ek 10s o4 3
HhEE A AL 1E, HuhbE e

IEWEERE, 2y
HiProfibush ik, 5 &=
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2.4 H{5H 0

2.4.1RS-485 ¥ 1

PM-127 77541485 510 EFRAEIRS-485 10, LU R4/ fRS-485 Hpfk

& RS-485 ALABIARIEARFE
@ MZIhh: LelhE g, P I A 2 A b v R 5

@ R 1200 bit/s~115.2Kbit/s;

@ A BEROWS RS, WaTHUE bR, BT REE A (EMO;

@ i BG BEAYBE 32 ANl Ok, 23127 ANl Gishgk);

® kiER: 5 T T

€& RS-485 fEHm & AT A

@O AL RS-485 M EkIER

@ MBI A AN BRI, 120Q 1/2W BT 4% i 521847 .
AT LR A PSR S SRS 1, F R DURS AR IR 4R R dh A T He 2k

518 Thhe

A+ (RS4A8SEHEIE) , HEHH FRS4A85BE 44 B 1

B- (RS485%i#11) , EHH " RS485% £ K dis 71

GND (f55Hh) , nJiEike:

AW | =

24V _GND (HijiHh)

-7 -
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! 5 ! 24Vt P

2.4.2PROFIBUS-DP i 1

PROFI-A
6 | 9
O O OO
o o |o O q 5
PROFI-B | GND
DB9 5| Thee
3 PROFI B, #iiE
5 GND (nJi%i%ER)
8 PROFI A, ##ift
-8-
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3 PREN AR

LAR JLAS 25 BT AR IE N S 1) PM-127:

1.

45 PM-127 bHL, Xkdidl, BEA Profibus-DP il ¥ BAL, L2 BOARBNIHS 2.3 B3l )i & PM-127 1)
Profibus-DP Hiulil:.

1 GSD 3015 A EIHE1f) PROFIBUS 41488 fFH, PM-127 /24 Modbus 35 RIS I 1) GSD SCAFAN I,
AR 75 22 N IEHA 1Y) GSD SCfF.

7 PROFIBUS 4158 FH, ¥ # Profibus-DP Mufidthhil; R4 450 75 200 & Modbus (RS HU L. Sy
4, RKE PM-127 AR IRT i N\ i H A 31 PLC B & Profibus E 54 IR A7

P A T RS-485 I WU B, QMR IERAIERE 5 1 IR 5 IR R 2k

2 55 — %% PROFIBUS-DP it LB, RG22 3 K1 8 i1

HEFLLF Modbus £ 1 Profibus-DP M{5 4k, 47 PM-127 L, #EAIEFEGRE.
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4 Profibus-DP WA HRHSH K E
4.1 ZHEE N

7t Profibus-DP 3 21 25 51 b 75 2L B 1 S5 45: Profibus-DP M J&PEZ 4. Modbus i34 Module

Profibus-DP M3l J 1 25 45 Modbus Sl THIEAERE 5 DTS5, S 4700 BN 1] | 58300 ZE I 15 ) BL &2 Modbus
M HRE CSE AT 0

Modbus 714 Module Z%${: 245 Modbus T-3iff, Modbus fir4 Module Z¥if: Mufisthhl. ZhighD.
Y/ GBI RN TR

4.2 ZHPREILE
4.2.1 GEH T2

1. 47 SIMATIC Manager 'FI‘. , i 1

RS SINATIC Nanager
File PLC View Opticns Niodow Help

O e(82 ] %] =] 2|

2. il File->New, #rat—A TR, Wil 2:
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Fils TIC Vi

Dlsleri=] ¥l =) wl

sar project= ILi'In--r'u:l

Hass | Stocaxs psth
T B wSienens'Step? \ETprej \Tn

Hane
o

Skerags Locatimm fpath]
JE S menx 5 L TS a5

3. Insert->Station->SIMATIC 300 Station., W& 3:

o T EODRTS
Eile Efit Josert FIC Yiew Options Nindon Helg
0| %] ] oG] 8] ol [= Pw| Eof [ S [ e pide > =13 =] w2
'ir'JEr_ BODADS — E:vSiemenz\StepVySTproihT_modbos
MET D [ STMATIC 300010

[@ STUATIC 30nii)

Kl 3
4. Xt SIMATIC 300(1)->Hardware, ] JF S7 PLC AfifF4IZs S0, Wik 4:
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W I SINATIC Nanager - T_NODBUS

File Edit Insert PLC ¥iew Optitms Window Help
D|e|2? | & %o gl (o % %)== & [ orie ~1%| 3l&| x|

"5.? T _HODBHUS — E:\Sicmens\Jlepi\3Tproj\T_modbus

=l I_MUDB‘US
35 STRNATIC 30001

K 4

5. RIS 5 s, AN GSD SUAF T AR OGS T TR ASE H

s
oy it Inasri EIC Yiew

niél-éll % =] e gl!lElEEEl

2l [Eraninrd |
[+ ' EANPIEVS IF

| Bl STMATIC 300

[ Bl STHATIC &0

Bl SIMATIC PO Baxed Control S00/4
B SINATIC PC Siadion

bl

ol

< 1 | =
E

FEOFIPUE-IF =leves Ecx
SINATIC ST, WT, and O7 (
distributad rack)

Fress FL te get Help.

K s
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4.2.2 ¥ GSD 3¢

PM-127 /£l Modbus =35 FI SIS () GSD SCAEANTR], AR 75 22 5 N IEAf ) GSD SCF. AT TER A
FEAAEOE *.gsd SCAFEHIEILL R #%42:  Program files\Siemens\S7tmp\
1. e 5 thoCHYET TREAASE NG, sidiZHA” Options->Install GSD file, 41/ 6:

:[;HI Config: Configuring hardware

Station FPLC View FEASEIAS Help

J O 2= q"' Customize. .. Ctrl+al++E
i

Edit Catalog Frofile
Update Catalag

Install HW Updates ...

Find in Serwice & Support. ..

Create G5I file for I-Dewice

Kl 6
2. FRHIWE 7 BN H, %P PM127M20.gsd B PM127820.gsd, fiili“Install”, 3 Mt5e)E, Hidi<Close”,
RIS H

www.sibotech.net -13 - S i b 0 T ec h®
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Install G50 Fales

Install GED Files: Ifrl:-m the directory LI

IC:\Prngram Filez'SiemenzhStepT \STtmp Erowse ... |
File I Releaze I Yersion I Languages I
PC150V20. G500 ——— - Default

FM1Z20. g=4d Default

Default

3 Default

FM1E .g=d Default
FMIBOT30. z=d  —— - Default

EMIZT Modbus Slawe ¥2.0 (EML2T)

Install | Show Log Select A1l Deselect A1l

ar |

Kl 7
3. FESEHARLPERE Options->Update Catalog, 7& Device H %™ 5B BTy i34, fn] LAE A g
/Profibus DP/Additional Field Devices/Converter/$k 2 83 WHEA % 4%, W1 8 k.

www.sibotech.net -14 - S i b 0 T eC h®
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- %? FROFIEVUS IF

=[] Additional Field Dewices
- D General

-1-[_] COWVERTER
B FCA-100 V3.0
&g FCO150vED
& Fmezo
&g FmizoT
B IMZT Modbus Master
E FM1ZT Modbuz Master V2.0
B P27 Modbus Slave
B IM2T Modbus Slave V2.0
Uniwer=al module
Status
8 Bitz Input (Dxzux)
16 Bit=s Input (Dxxxx)
24 Bitz Input (Dxxxx)
32 Bitz Input (Dxxxx)
40 Bitz Input (Dxxxx)
43 Bitz Input (Dxxxx)
56 Bitz Input (Dxxxx)
B4 Bitz Input (Dxxxx)
TZ Bitz Input (Dxxxx)
80 Bitz Input (Dxxxx)
83 Bitz Input (Dxxxx)
98 Bitz Input (Dxxxx)
104 Bits Input (Daxsa)
112 Bits Input (Daxsa)
120 Bits Input (Daxsa)
128 Bits Input (Daxsa)
E 8 Bits Output (larxx)

K 8

+

+] o[ [E] [ [ [E

423 HEWE

1. FITE AN TR A B AL H, BEE PLC rack, Mili“Hardware Catalog\SIMATIC 300\RACK-300\Rail”,
Wil 9 FrR:

www.sibotech.net 15 Sibo TeCh®
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;2. H¥ Config — [SINATIC 300(1) (Configuration) —— T_NODBUS]

L
E"]Etation Edit Inzert FLC VYiew Options Windev Help =Ii|£|

D[=[z-19 %) 8 dnfsia| 2 % we|

R

~

Erofi IStandard LI

#-% PROFIBUS DIt
= STMATIC 300
w0
#-(Z3 cr-300
=0 CPU-300
-] CPU 312 RN
(1 crr 313
[ cPU 314
CFU 314 IFM
-] CPU 315
=13 CPU 315-2 TP
[8 sEs7 315-24F00-04F0
|8 ers7 315-24F01-04E0
Hew. . . BEST 315-Z2AF02-0AED
= (] BEST 315-2AF03-0AEO

Properties. .. | BEST 315-ZAFS2-0AB0
= [¥-[] BEST 315-2AF&3-0ARD
_ vdete | (2 CPY 318

E
-0 CFU 318-7 TF
-] R 31E-2
[+ CFU B14
[+ CFU 7
#-(C] m-300
w0 M-300
i i FEEh #-[Z2 MT-EXTEFSION
#-(C] F5-300
o | =10 BACE-300

Properties — PROFIBUS interface DP Master (RO/S2.1) [

Genearal Faramatars I

Address: |2 vl If a subnet iz =zelected,

the next awvailable address is

Subnet:

|=

|~
|

(T )}
[+ SIMATIC 400

:l" IMATIC FC Based Comtrol 30049
78 SIMATIC PC Station

el

= Hodule ... | Drder rumber ... | MBFI address | T add.. H addrezz | Conment

|

< ] 2

|
EEST 315-ZAFO0-04E0 a £
43 BB work memory; 0.3 ns/f — —=
1000 instructions; MFI + OF —
connections; for multi-tier

|

Al ||| raef

Fresz Fl to get Help. | Chg

K9
2. W CPU il JEFEXT IR &SRR 5 H RS AL 5

3. & Profibus-DP M %%, X & Profibus-DP: New->Network settings, ¥ DP, iE#—MEr %40 187.5Kbps,
SRJG “OK”, Xidied; Wikl 10:

www.sibotech.net - 16 - S i b 0 T ec h®
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B Gtetben BAie  [awern JIE Wres Aptisor Kimdss  Help ;.-Lj_!-l
DleE2 (% & ] bl of@ 2wl
i [rmdud =]
T+ B PROFIIG IF
|| = H smwTIc 30
Propertiss — PROFIEDG interface NP Master (RO/S52.1) T%%
Gensral Poraselors | i 5 gg ::: o
s F = g T L =g

CE 515-2 P
SEST 315-ZAPUO-ORED
SEST 215-ZARDL-0ARD
ABST FS-FARNS-0LED
#1] SBST 315-ZAPOZ-OAED
SBST A1S-ZAPRZ-DAID
¥ 0] SEST 315-ZARRI-OARD
& £ cey S1e
# ] CFU 3B~ OF
L0 cr mp-2
| CRIF Bld
i O3 cev my
-] m=200
— & ) mem
ERE -] MT-EETIHSTON
| Brofils: ] pe-a
£ ] Standerd

Upiversal (IF/FRZ) lug Paranatess . I &3 AR
Izar-Defined B il
g g

I [ SImTIC 40
5|l wotle oo | Order wmbaer & [{l] STPRTIC FC Based Comtrol 30044

8 FIMTIC FC Flals
Wi | v | o ||v8 ki
< L | EH
[EE=7 SrE-zimn-ouma - E-I.‘.I
qB XE werk mimery; 0.3 asf T
LOOD imsheueibena; MPI 4+ OF
canmectican. Sor mulii-tier o

Propertics = Hew subnetPROFTEDS

apsral  Heiverk Jetiings |

EEa T

Tranzaizeion Bake;

1| el un| o | co ra| =

A

&

Fraza Pl be gt Halp

K 10
4. %&F Profibus Master station Huhk, il 11:

www.sibotech.net -17 - S i b 0 T ec h®
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3:H¥ Config — [SINATIC 300(1) (Configuration) —— T_NODEUS]

B zrotion Edit Insert FLC View Optiens Findow Help MER

2 Brofi |Ztandard |

=85 FROFIBUS DF
=-[@] STMATIC 500
i mm i
[+ (L CP-200
1= L3 cru-300
| @ CPU 312 IFM
[T N ol TE:
_ = . L O ery a4
bideess: P= Tt R e e e Dovan
- ¢ =3 cru 31s
=[] cPU 315-2 OF
[@] oEST 315-2AFO0-0ARO
|TI BEST 315-ZAF01-0ABD
| srst 315-zaroe-oaso
F.[_) BEST 315-ZAFO3-OABD

_Froperties.. | - [@ BEsT 315-2aFAZ-OARD
Dalat i (1 (] BEST 215-2AFA3-0ARD
—Dadets |  wCaeu st

 #-{J) CPU 316-2 DF
¢ @[] P B18-2
[ CRU R4
¢ CPu MY

[+ (L0 Fm-z00

=3 IM-300

HHTE | HEdE TN | |z||_‘| WT-FXTEHSTON

Select Profibus Address

Propertiez — PROFIBEUS interface DP Haster

General Faramatars |

Highazt address:lZ6
Transmizsion rate l87T.5 kbit/s

(L Ps-z00

-1 (22 RACE-300

o Bail

mUR LA s

[l STMATIC 400

l TMATIC FC Based Control 50074
1+ E SIMATIC FU Statien

|#

Booo E Meodula .. | Order zumber ... | MFL addreszs | I add .. Q addrazsz | Commant

T [

4 i

L] | =
BEST 315-ZAFO0-0ARD ~ EI
48 BB work menory; 0.3 m=/

1000 instructions: WPT + DF

connections; for multi-tier

trasz Pl to gat Halp. | ~ o
K11

H5 Mt PM-127 FC A £ PROFIBUS P48 BC & 4, R4 A o th Bt Sl 21 S7-300 i He 12 2 1

WAEET, ik 12:

| m|ofe|w|ra]—
|
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@;Hl Config — [STNATIC 300 Station (Confipuration) — PCAlDOTest]

B} Station Edit Inmert PLC View Options Hindow Help _ 8 x

D=8 § & i =

~

Find: |
PS5 307 5A

CPU 315-2 DP — | Profil  [Standard

o~

=
= o
[f Lof 12

5 .
FROFIBUS (1): [P master system (1] @@ EM2T Modbus Master ¥2.0
p) Tniversal module

Status (B Commands)
Az K e o Status (16 Commands)
s KA YA 2 21 Status (24 Conmands) )
I L Status (32 Commands)

Status (40 Commands)

S Status (43 Commands)
Exception Codes
Read 1-8 Bits (xxxs)

ead 9-16 Bits (Omuxx)
Read 17-24 Bits (Daax)
Read 25-32 Bits (Daux)
Read 33-40 Bits (Daux)
Read 41-48 Bits (Daux)
Read 49-56 Bits (Daux)
Read 57-64 Bits (Daux)
Read B5-T2 Bits (Daux)
Read T3-80 Bits (Daux)
Read 81-88 Bits (Daux)
Read 89-98 Bits (Daux)
Read 97-104 Bits (Duumx]
Read 105-112 Bits (Daxx)
Read 113-120 Bits (Duxnx)
Read 121-128 Bits (Duxnx)
Read 129-136 Bits (Duxnx)
Read 137-144 Bits (Duxnx)
Read 145-152 Bits (Duxnx)
Read 153-160 Bits (Duxnx)
Read 161-168 Bits (Duxxx)
Read 169-176 Bits (Duxxx)
Read 177-154 Bits (Ouxnx)

GRS

=2

£ Ed

| (3)  EMLZT Modbus Master V2.0
.| or10 .. | oOrder Number / Designation [T Add.. |Q Address |C 7 |

S0 Read 1-8 Bits (Dxxxx) 0 A

o

Insertion possible Chg

Kl 12
BRIy WS, 5558 PM-127 kR (PM-127 Modbus Master V2.0 5{# PM-127 Modbus Slave V2.0) i %
Jr BT MZSECE Y, 463 Profibus-DP R4k b, BUARSRMIBIR, FomnTLURA T . 58 0 R Hdn i z)
BT ARG R A T, RS SR, BT LUBON, AN T U $) PLC A AF .
Y : PROFIBUS-DP M [y tthdil 2 55 e (1 15—
6. W E Profibus-DP M3 J& 1S4 S AH G Modbus 174 Module 24, 155% 5.2.4 %41, /(7 JF F 43| PLC.

424 ZHRE

ESHE 2 0, A7 2E T ## PM-127 Modbus Master V2.0, PM-127 Modbus Slave V2.0 % FH1EN
Profibus-DP M i (¥ J& P S H UL K 25 B BT SRR AN A Module 1240,
B PM-127 Modbus Master

FEM5E PM127M20.gsd S5, 78 H s H n] fENZ A FR I3 7%, Bt & Uit PM-127 7E Modbus ¥i{F 4 Modbus
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< Profibus-DP M5 @M%
EAAFI, Xk CHEENE] Profibus-DP 4% |1 PM-127 Modbus Master V2.0, 3 H 18 J& = 5 i tn & Bt

7N
Properties — DP slawe r>—<|
(General CFarameter As=zignment l
Parameters Yalue
= aﬂtatinn parameters
= aﬂevice—specific parameters
E] Baudrate (bpz) gB00
E] Data bits, Parity bit, Stop bits |5 Hone 1
E] Frotocoel Type Modbuz Master
Eesponsze Timeout 300ms
[£] Resp
E] Delay Between Folls Ho Delay
E] RTU
= a]'[ex parameter assigoment
[Z] User_Prm_Data (0 to T) 00, 00, 0o, 40, a0, 03, a0, 04
Uzer Prm Data (5] ]|
] Vser_FPrm_
AR E 2 H 45

Baudrate (bps): FCE & I3, 300, 600. 1200. 2400. 9600. 19200. 38400. 57600. 115200bps

Ak

Data bits, Parity bit, Stop bits: At E &l Az K% 77 LA A5 1847, 8 None 1. 8 Odd 1. 8 Even 1. 8 Mark
1. 8 Space 1. 8 None2 HJi%;
Protocol Type: 445} £| Profibus-DP £k I [1] /& PM-127 Modbus Master, %1 4 “Modbus Master”; 4

165 3 Profibus-DP M2k [ [{)2Z PM-127 Modbus Slave, M1ZIi 4 “Modbus Slave”;
Response Timeout: > Protocol Type A Modbus Master I H %L, 100, 200. 300. 400, 500. 600. 700

800~ 900, 1000, 1500, 2000. 3000, 4000 5000ms HJi%;

Delay Between Polls: * Protocol Type 4 Modbus Master I/ 5%, No Delay. 50. 100. 150. 200. 300.

400, 500. 600, 700~ 800. 900. 1000. 1500, 2000ms HJik;
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Transmission Mode: [ & Modbus il #f£5,, RTU. ASCII nJi%k;

< Module 2%
RS, A CHEShE] PM-127 XML T 772k 1 Module, 55 HS 1 J& P S i F B s

Propertiez — DP =lave &|

hddrezz f ID Farameter hzsignment ]

 Parameters | Walue
[£§ Station parameters
=y Device-specific parameters
rg] Slave Address 1
{-[Z] Function 15
F[E] Starting Address 40
Ho. of Foints g
El
e |

e | wag

AR M SR

Slave Address: ¥ & PM-127 [ 25i%E42 1) Modbus Mufiffj ik, 1~247 Wik,

Function: G &, DIRERSA & EXF M Module;

Starting Address: ¥ E 7 f-am L if ik, 0~65535 Wik

No. of Points: ¥(#i5/M4, 45 01H. 02H. OFH ZhAEAD XN Y Module i 524 B 4l AN %

< FH Modbus #r4 Module

PM-127 /24 Modbus Master I} 3 #5[1) Module f4#F: Status Module. Read Module. Write Module

Status Module: Status(8 Commands)~ Status(48 Commands). Exception Codes

£ Modbus 3fi, Profibus % A] LL ) Modbus @& (KPR, S BtPiRl Modbus fir & RS ML DI fg -

Status(8 Commands)~ Status(48 Commands): 6 % 1, &M R EE 4 Modbus iy 2 RS, W WY Eff
B, WNSEH E N BT IR T EOR R 3 RIS, THEE WY R I TS
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a) Status(8 Commands): it 8 54

b) Status(16 Commands): Hifil 16 &4
c) Status(24 Commands): Wit 24 &4
d) Status(32 Commands): M 32 £ 2
e) Status(40 Commands): MK 40 £ 4
f)  Status(48 Commands): itk 48 sy 4

Exception Codes: 4 1word Module, 571947~ Modbus 22K 5] 0~ 47; K7 KR A el s 1540
UM N AR ISR R A A 05 M SRR | R I R RN e AL A, AR R AR, W IV I B
BRI AR5 OXFF

Read Module: Read 1-8 Bits (0xxxx) ~Read 249-256 Bits (0xxxx). Read 1-8 Bits (1xxxx) ~Read 249-256
Bits (1xxxx). Read 1 Words (4xxxx) ~Read 64 Words (4xxxx). Read 2 Words (4xxxx) Consistent~Read 16
Words (4xxxx) Consistent, Read 1 Words (3xxxx) ~Read 64 Words (3xxxx). Read 2 Words (3xxxx) Consistent~
Read 16 Words (3xxxx) Consistent

24 Modbus 3, SZRFA Modbus 214 Module @1 EAT&, i)™ Al R4 i 224680 AR (1) Module FF3EAT
fE] FAH DG B B HI AT

Write Module: Write Single Bits (0xxxx) ~Write 249-256 Bits (0xxxx). Write Single Words (4xxxx) ~
Write 64 Words (4xxxx). Write 2 Words (4xxxx) Consistent~Write 16 Words (4xxxx) Consistent

14 Modbus 3, SCFFH Modbus 5 iy 4 Module 41 FFri&, Pl s 7 ZHa 30 A [F] ) Module F3E4T
fA] ARG B B B AT
B PM-127 Modbus Slave

FEM5E PM127S20.gsd SCIFJE » £ H 3l $R B2 A AR K BE 46, it i PM-127 £ Modbus i {1y Modbus
M o

% Profibus-DP M /EHESH:

FEAZS G, At CHEzh # Profibus-DP M4 (¥ PM-127 Modbus Slave V2.0, 5 H )& o4 7 iii i & i

N
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x]

Properties — DF slave

General CFarameter Azsignment l

Parameters Walue
= aStatinn parameters
= aﬂevice—specific parameters
E] Baundrate (bps) 9500
E] Data bits, Parity bit, Stop bits |8 Nome 1
E] Protocol Type Modbus Slave
E] Slave Addre=s 1
E] ETU
+ D Hex parameter assigmment

ARCE S

Baudrate (bps): P& & D%, 300, 600, 1200. 2400, 9600. 19200. 38400. 57600. 115200bps
Clp

Data bits, Parity bit, Stop bits: Bt & A7 #5677 XL K& AF 1147, 8 None 1. 8 Odd 1. 8 Even 1. 8 Mark
1. 8 Space 1. 8 None 2 W ik;

Protocol Type: *4#:5))3 Profibus-DP &2k | [#] )& PM-127 Modbus Master, JIJi%Z i 4 “Modbus Master”; 4
Hizh #) Profibus-DP £k I [f] /& PM-127 Modbus Slave, Ni%i J“Modbus Slave”;

Slave Address: 4 Protocol Type 4 Modbus Slave 4%, ¥ E PM-127 14 Modbus Mufiff ik, 1~
247 Wik,

Transmission Mode: [t & Modbus il ik, RTU. ASCII AJi%k;

< Module 2%
RS S, Al CHEENE] PM-127 XM F 5 2k H1(1%) Module, 58U H (1) J& P£ 54 th B s«
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x]

Propertiez — DF slave

Ahddrezz / ID Farameter Azsignment ]

 Parameters | Walue
_a Station parameters |
 L[Z] Function 3 F IR
+D Hex parameter assizmment

Cancel ] Help ]

Hirrs
Function: 43635 — Module I, Function &€, #/~i% Module 32 77 1) Function fHE 03H (3),

06H (6). 10H (16).

< 3ZFFH Modbus 174 Module

PM-127 {4 Modbus Slave I 3 ##¥] Module f445%: Status Module. Input Module. Output Module

Status Module: Status

£ % Modbus M3, Profibus 3ifi i LU Modbus 441k 4, Profibus Hif2ft Modbus M4k Module,

AN, R SRR SRIN, R I

Input Module: 8 Bits Input (Oxxxx) ~128 Bits Input (0xxxx). 1 Word Input (4xxxx) ~64 Words Input

(4xxxx)+ 2 Words Input (4xxxx) Consistent~16 Words Input (4xxxx) Consistent

14 Modbus Mili, SCFFH Modbus 13174 Module 41 FRri&, I f s 7 ZHE30 A [F] ) Module F3E4T
fia] B AR SR B AR AT

Output Module: 8 Bits Input (Ixxxx) ~128 Bits Input (1xxxx). 1 Word Input (3xxxx) ~64 Words Input

(3xxxx)+ 2 Words Input (3xxxx) Consistent~ 16 Words Input (3xxxx) Consistent
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£ Modbus M3, SCHE) Modbus 5 iy 4 Module W1 FATik, I rTARYE 75 ZEHa 8 A [F 1K) Module kAT
fi FRAH DG B B B AT
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5 Modbus . Muh TAERE

5.1 Modbus F it T{EJRIE

PM-127 Modbus Master (] Modbus Fi! PROFIBUS . [i] [ 54 4 4 8 1k WS 5% Fok g ar. 41 PM-127 T
PIUEAR 22 P IX, — B PROFIBUS WZHm A ZZ X, 5 —Hu& PROFIBUS M £ 4t 221X . Modbus 12HK
A BB BN B N 55 N2 X, i PROFIBUS 4% 525 . Modbus 5 25 17 % 2 1 fir 2 M 190 28 i 1 22
X EHCEE, 8IS A 2R Modbus B

LIPS U RS L g2 X
—' N
—T—/ Modbus
Modbus > w1
w1
~
Modbus >\A Modbus
w1 1
l/

SZFFO1H. 02H. 03H. 04H. 05H. 06H. OFH. 10H “5IhRefY, HIJ Al DAL S 48 4 Modbus ir% Module.

5.2 Modbus Mk T{EJRIE

PM-127 Modbus Slave [¥] Modbus #1 PROFIBUS - [] {1 £ 4 % #ifl i “BRSR 0 ZOR AL 7E PM-127 Ay
PIYEARZITIX, —Hud PROFIBUS BISHIA 201X, J—3UE PROFIBUS MI&HIH Z2nPX . Mg
A 2 o X A T PROFIBUS 15 75 (K. Modbus 5 25 17 % 5 iy 4K B 5 N 2 W 4 i N2 b X, it
PROFIBUS M£532 . Modbus 3325 fiir 4 A W4 2% 4 tH 22 b DX ICEGHs 3t el mia AR SCAL 4 Modbus 23 B4
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PROFIBUS PROFIBUS
N2 P X 22 R X
4XXXX 3XXXX

Modbus By 4% :

06H #1 10H

Modbus BEAT 4 :

03H

00000 (40001)

00000 (30001)

00001 (40002)

00001 (30002)

00002 (40003)

00002 (30003)

Modbus BEAF 2

0xxxX

1xxxX

Modbus By % :

05H 1 OFH

Modbus BEAF4

01H

00000 (00001)

00000 (10001 )

00001 (00002)

00001 (10002)

00002 (00003)

00002 (10003)

Modbus BEAF4
02H

J& Modbus EuhFiH,

Y Modbus ZFfFas bl 3 X (3xxxx). 4 X (4xxxx). 0 X (Oxxxx) 11X (1xxxx); FHHA,
TIEERS 04H; 4 X SZEFINEERS 03H. 06H. 10H; 0 X S H:Ihfgfd 01H. 05H. OFH;
PROFIBUS-DP #ii A 2% i1 [X X+ Modbus —1ill,

1 X ZHF Yy ReRS 02H;
WL 1) Modbus TR HFZF /748 4xxxx

(fEF] 10H #1 06H fir 5 A& s, A8 H] 03H i & [ml B idls ) M2k Bl Oxxxx (] OFH A1 05H fir & 5 A%,
T O1H g & [l B 4D .
PROFIBUS-DP it 23X % -T- Modbus —{llf, & Modbus =354\, W4 %] Modbus %1 A 25 77 4% 3xoxxx (fif
FiI O4H iy & B BB A AT Ixxxx (] 02H fir & B2 EUERED -

2 SiboTech’
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6 Step7 WA 5 M I

PM-127 12l Modbus Master SCRFK S8 5631 Modbus 74 Module U1 N i :

Read 2 Words (4xxxx) Consistent~Read 16 Words (4xxxx) Consistent. Read 2 Words (3xxxx) Consistent~
Read 16 Words (3xxxx) Consistents Write 2 Words (4xxxx) Consistent~Write16 Words (4xxxx) Consistent

PM-127 11: ) Modbus Slave S FFK 5% 5E #4 1K) Modbus T4 Module 41 1 7

2 Words Input (4xxxx ) Consistent~ 16 Words Input (4xxxx ) Consistent. 2 Words Output (3xxxx) Consistent~
16 Words Output (3xxxx) Consistent

XK 52 441 Modbus 774 Module, 7E Step7 gwFeE I Z0R T WUk IE Sl FT Uk IE S F %
HIFI SFC15 (JTHK%) F SFC14 GTRIEND.

“DPRD_DAT”
—EN EHNO
WH16#0 JLADDR EET_WAL [-NWs0
F#DE100,
DE¥D. O

EECOED —EYTE 16

SFC14
“DPWR_DAT”
EN EHNO
W 16#0 qLADDR EET_Wal |-MWGO
PRDELOG,
DB, O
EYTE 16 —RECORD
SFCI15

XA e AL E Modbus 74 Module, 7t Step7 g f2 i 7] LLE A3 H] MOVE $i3-4 % B HEAT 32

e

Ejo
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7 RA
7.1 HUHRSE

RsF: 100mm () x70mm (55) x25mm ()

L 70 43
4 \

/ IR iSere s )

100

\ / PAL: mm

7.2 LHTTIA

35mm DIN S 22%%
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@ —l @

m M

(D (D Iy (D)
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8 BATHEY LIE RSN

B AT R, BLB AR AR o

BT i, AT eSS BRI IR

PEr L AR AR Ul W P I RV Y, DLRTREEBEIA .
BRI b HE K, K S K5 1% TAE
TR R A R, AT O R A

R
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9 WAUER

ARt Y15 b B R B AN ZE B R AN T S o TR 2 WIAE P R R A R RE TR, A AT REAEANE ST
TR O X whEA T U -

SiboTech g |31 A 2 LB ARA B B KEE MR .
BT VR T, AR R DA T A R AR D R 45 AT S N 1) e A, A I,
G R AR o
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Mi3¢: Modbus 1Y

Modbus-RTU Hpil:
Pl 5P SR TR A A Modbus 421, ]I 4% Modbus PR ZRAF & RTINS, AN a4t
P e il kg .

LU A

WELZ: AEHr 7 RS485

WAL 0-247

THTHPRF R e

WA PRl S 2k

i EMNE T A

PR — R TR BN R CEXND), IXEE AR Eing bEY
B IPANTT nfE5r. 1556, ErENGES FHER—a M &k g (AP, ARG, EMRTT1
b P £ R N A S AR 4 L.

SO SRVFAE BV RN 2 i £ 2 1), AN SRV I 2% 2 () IR O AS 3, IS S AEAE EATI0I 4G
AN 7 P TRER 5, TS PR T . B IA AL A S 5

— NS

1 fEanfr, 8 frdm, 1A 5 ibfr.

— MR g
Hohik igend Him ]
8-Bits 8-Bits N x 8-Bits 16-Bits

PRCEA 2 LTRSS B P A A, X e R R e A A e L BN 4

BRI R IA L, Bl AR R TR SRR R, ik L

B efs B CBdEsk), mlBEdE, WREAER, MPATEIEIOE KT, ARG, SR A AR
PE OB (5 Erp, B mR [0l 25 K% 3 . R Bl m B 3 5 T A R N2 2y AT HE
(Address). #HUAT T 162 (Function) AT i 2 2E B I K 2085 (Data) Fl— MR 5% (Check) o K AAT AR B 1%
HBAN AT LI ) W[5

Mk (Address) 1

b AEMT TFAG T 5y 8 A (0~255) 2R, IRESALARI T 45 R I K 4
Fhhl, BBk A5 IS I LB o RS 2 15 46 T kil DA 2502 ME— 11, AN SO A 5k 380 11 28 v
S ML T e A . 2 e A IS R AN R, S R LB EE B AR 5 VR T NS L E S 2
HATIEAS .
Ihife (Function) 1
DyRedl A & i T 4% Mk R I BT R IIRE . & 1 -1 50 T Ira Zhetd . EIn & S e 1]
WHINRE .
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* 11 Ihnehs

(%] =94 (]

03 P RAF A A A7 A I 2 AT
06 THUE 55 A7 JECE MR I RS AT
16 TiE % W A7 JBCE R E 1 R RME R — R 2 AT
e/

il A S T E I TR 52 L REPIT 5 R B sy g i . 2 0 IR AR B B . X
LR I N R RERERUE . S AL BE R AR Bl DHRESRS T VR s A AE s, A ) = 2
7 W M BIBAN B A7 25 T 46 SO 22 DA B, oA R Pt R0 0 R SR R AL 0 (R AR ] 8 T BT AN T

BURAZ

I SVE BNV L B A R T OB R . A, T R AR T, 41
PaAE N— DI AT R ) — DB INE L ERTRES A — 20 0ie, AR IR IG RE A% DR UE T2 L s 28 i A 25 )
RS A A T R R, R R e T ARG e EANCR, IARREAE T T 16 LRI UAR IS
%
[AE] KIEFFSEGEARRR — duhb. THEeRS. HeiN Iy A H A A

BRI

PERICRIRE: (CRC) N BT, A% T —A 16 At —HEHE. CRC {H ik
EEATIE R, ARG RIS b, Bl s e AR I FOR v CRC H, AR5 5031 CRC
HPESET ILER, WX PIAME A, B A T R R
CRC IZHI, Bk 16 ML 7R TNE A4 1, ARG IESHEEER Wb 1 8 AL
i a e M9 BT s 8, AU T 1) 8 MR 2 545 CRC, IR, AL A7 DL AT BeAd FH 1)
FHRAL AR A CRC.

TEAER CRC I, REAS 8 AL W S T A7 P N AT 8L, AR B & R AL, s A <0 %h 72,
BARAL (LSB) B H AT, S 2 1, A At 5 — AT i e (T — IR R Bus 8, wREARALA 0,
AMEATAT AL 2

IR ESZ AT, MIEPATE T 8 IRBALEAE, MEE 0 G841 BllE, F—A8 s
AAEAM I AR T s 5, AT FIR B 5 — A 8 IRBEAT S sl AR, B AR T A T
AREE, AR IR B AR 2 CRC i

A CRC HITAE R -

THE —A 16 f7 294728 8 OFFFFH (4 1), ¥RZ A CRC Zifras.
FEEARE T A 8 AL S CRC ZA7a P IR T T R s 5, 45947 0] CRC A7 4% . ¥ CRC % A7
WAL, BEAIERL 0, AR H IR .
WG 0. FEEH 0 CF—IRBAD.
WERBARAI N 1: K CRC Ffea 55— AP [ 2 (5 (0A001H) AT S elia &,
ARG =S VE HE 8 RFEA. XFEALPESE T — N2 51 )\ 7.
A 2 DRI S DR —A)\ L7, HBIPFTA AR BEE .
% CRC T A7 afHE /& CRC HIMH.

2. NHZTREEM
O T UM EE, AT HE AT AR T DU TR SR AR ik DU S P50 L A A S S A
TEIRERE B I RERP o
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A2 R PSR T BERAE a1 2 — 1 sk, Bk 16 kD
Hhhik Difehy A mEidaih |BERE  |[TENA [RERA (R (AR
B3 gc=T e A W 10210 . < N b = W o 2 W . 3 T
03H 03H 00H 01H 00H 03H 55H E9H

K 2-1 st

BEEUE (DhEERY 03)

Y i)
B2 —2 BB 03 5 MHLEE 3 AN KRAE B 3L A% U1,U2,U3, Ul fHihl 5 0001H, U2 fhik 4 0002H, U3
Friht >4 0003H,
bk (Thaesd | ERl [RERG  |RENA [EE RN RS
Hohb 2 MRS [Boasy | BUREy |[IRFE S
03H| 03H 00H 01H 00H 03H 55H E9H
K 2—2 i Uca il Ta M2 HELE Ini
VA
Wi A5 K LRE . Shfeid . Bds i BeE I CRC AR5 .
Kl 2 -3 [l s U1,U2,U3 [ Y
ik |ThEE (AR R |BE |[TE TR |BE |TE | (B
] M |Em |[ER |[Es [ER |(Es (EE |56 (50
S S N S T 2 I o I o o T = v Ui R =
210 il il
03H 03H | 06H | 01H 7CH 0lH| 7DH 0lH| 7CH |[F9H [9BH

K 232 UL,U2,U3 (110 [ 5w

2. 2 WUEZ % A74s (TIRENS 10)

it

ThREs 10H FeVFHI SR 2 A A N A, Be& T MEFTHLIE TR BB I 2 16 MR fEH 2

LA A7 TAER, AR AT I 20 AT LTS3 2 A7 0 N

B 2-4 JEAB T3 5 M BE A IR g i 1 A3 e 4% 2 AR sh AV R e I i) Ta) A0 8 s A, e a1 sl e
SEAE ML K 2AH, ZE IS A] 8 2 5 A 2BH, I 4% 2 IS VE W E (bl 4 2CH, ZE I A % 218 4 2DH.

b (Theg R |RE |RE (R |RE (KR |RE (RE |RE (KRR |RR RRE AR R R
(TN V5% B i e 11 [ R 1139 S 1= 1= K O 1= P 1= O = = = S - W =R E A A E A T
11091 O S 11 S I N I L I N = e Y = e N = e N = s N = e I = O i [
[ O = O = I = O R R
L
03H |10H |00H |2AH |00H 04H |08H |07H |DOH | 0O0H |0AH | 07H |0DOH |00H |0AH |25H |7CH
B7R 2-4 3 el i 1 AN 8% 2 ISl (F S S I I T PR B0 1
M J3
Wbt (ThEEY |(AEEL  |[REEE [RENAD RERA (RS (B
LR IR I Pt A O - R O .8 S o O - o 7
-35-
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03 | 1oH|] ooH [ 2aH | o0oH | 04H | EBH | 8DH |

B7R 2-5 BB i s 1 RSB 45 2 BB A A S IR N TW] £ ¥ 5 11 o 12

2. 3 THERZAA (DIREN 06)

i)

DIREND 06 FSLVFH /7 28 FRAN 27 A7 45 TR N 2%, DAE R 40 N 508 (AT An] 25 A7 #10 mT DAE FH st iy 2 ok i LA
REARAS 38 A2 LAl 24 77 sU AR, AT AT I 2028 n] DA B35 A7 28 P 2 o

TG R R 03 5 MHUE o B s/ Woe (8 Irl, Il kb2 002EH.

Wbt |ThfeRd (AREELG  |REES  |REE ARG RIS RO KA
Hudib S T [ HBHEAR S | T IR 7
03H|06H 00H 2EH 07H 0DOH EBH 8DH
K7s 2-6 1B B0 Beah 11 BOE(E Trl
M 3
X TR B A7 A U SR IR I W0 A A 2 A7 A (B S8 L R i 38 (0 i AR el 25
Wbt |ThfeRd (AREEL  |REELG  |REES REER (RS Rk
Mtk S MRS |5 T IRy 7
03H |06H 00H 2EH 07H 0DOH EBH 8DH
K7s 2-7 1B Bod Bah 11 BOE (E Il
- 36 -
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